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Fruit Ninja Games

Introduction
We are going to build a few versions of the fruit ninja game. We will start with an easy version
where every step (line of code) is given to you, but as you progress you will need to figure out
more and more details yourself. At each stage you should make sure you understand what is
happening, and if not then please ask.

À Basic fruit ninja game
Our starting version of the game consists of an apple that appears at random positions on
the screen and the computer prints out ”Good shot!” and draws a new apple when you click
on the apple, otherwise prints ”You missed!” and ends the game.

The steps given here come from the excellent Coding Games with Python book.

Á Code review

The CodingGameswith Python is very good, but it does do a few things that we can improve
on. So before we move on we are going to look at our code and see if we can improve it.

Â Adding sounds

One of the reasons we switched over from turtle graphics to Pygame Zero is to simplify
generating sounds — both short terms sound effects and long term background music.

Ã Keeping score

Currently the game just prints out a different message whenever you miss or hit a fruit. It
would be nicer to keep score so that you can show off your shooting skills. To do this we
will create a new variable called score. Also we will add a heads up display (HUD) to show
the score and game title.

Ä Moving targets

Hitting a stationary object is easy … what happens if they are moving?

So we are going to change our fixed position fruit to fruit that is thrown upwards from
below the screen and then fall back down due to gravity — now we will need some physics!

Å Varying targets

We don’t just want apples! Lets add other fruit also, after all this is ‘fruit ninja’ not ‘apple
ninja’.
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What happens
When the game starts, an apple appears on the screen 
for you to “shoot.” If you hit it, a “Good shot!” message 
pops up, and the apple appears at another point on  
the screen. But if you miss, a “You missed!” message is 
shown, and the game ends.

How to build  
Shoot the Fruit
This simple shooting game is a fun way to practice 
your aim. When the apple appears, click on it to 
”shoot” it. Aim carefully though, because if you 
miss, the game is over!

Pygame Zero Game

◁ Aim... Fire!
You need to stay  
alert at all times while 
playing this game. 
Lose your focus and 
you may miss the shot!

You can customize 
your game by 
changing the fruit 
that appears on  
the screen.

The default color  
of the game screen  
is black.
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How it works
The game is constantly checking whether 
you’ve clicked the mouse button. Every  
time you click on the apple, it needs to be 
drawn again somewhere else on the screen.  
If you click and miss, the game will end. 

Get shooting!
Are you ready to code? In this program,  
you’ll start by drawing an apple on the screen,  
then you’ll learn to place it at random points before 
you start shooting it. Ready? Let’s get coding!

Player clicked 
the mouse?

Player clicked 
on the apple?

Start

Draw an apple  
on the screen

Display  
“You missed!”

Display  
“Good shot!”

End

Open IDLE
Create an empty file  
in IDLE by going to  
the File menu and 
choosing New File.

1

▷ Shoot the  
Fruit flowchart
This flowchart shows  
the logic behind the  
game. The main part  
of the code is a loop  
that checks if you have  
clicked on the apple or not.

Oops! I missed  
again!

File

  New File

  Open...

  Open Module...  

  Recent Files              ▶

  Class Browser              

Y

Y

N

N

US_050-051_Shoot_the_Fruit_1.indd   51 23/02/18   2:31 pm

H O W  T O  B U I L D  S H O O T  T H E  F R U I T 51

How it works
The game is constantly checking whether 
you’ve clicked the mouse button. Every  
time you click on the apple, it needs to be 
drawn again somewhere else on the screen.  
If you click and miss, the game will end. 

Get shooting!
Are you ready to code? In this program,  
you’ll start by drawing an apple on the screen,  
then you’ll learn to place it at random points before 
you start shooting it. Ready? Let’s get coding!

Player clicked 
the mouse?

Player clicked 
on the apple?

Start

Draw an apple  
on the screen

Display  
“You missed!”

Display  
“Good shot!”

End

Open IDLE
Create an empty file  
in IDLE by going to  
the File menu and 
choosing New File.

1

▷ Shoot the  
Fruit flowchart
This flowchart shows  
the logic behind the  
game. The main part  
of the code is a loop  
that checks if you have  
clicked on the apple or not.

Oops! I missed  
again!

File

  New File

  Open...

  Open Module...  

  Recent Files              ▶

  Class Browser              

Y

Y

N

N

US_050-051_Shoot_the_Fruit_1.indd   51 23/02/18   2:31 pm

À fruit_ninja_basic

New File
In the mu-editor, click on the new file button,
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Set up an image folder
This game uses an image of an apple. Within 
your shoot-the-fruit folder, right-click and 
choose New Folder to create another folder 
and call it images. It needs to be in the same 
place as your IDLE file.

3Save your game
Go to the File menu and click Save As.... Then  
save your program in the python-games folder. 
Create this folder now if you haven’t made it  
already. Inside this folder, make another folder called  
shoot-the-fruit and save your IDLE file in it as shoot.py.

2

Save As:

shoot-the-fruit

Cancel Save

shoot.py

Tags:

Where:

Put the image into the folder
Go to dk.com/computercoding and download the 
Python Games Resource Pack or just the Shoot the 
Fruit images. Find the file called “apple.png”. Copy 
this file into the images folder. Your folders should 
look something like this now. 

4

I wish my  
folders were  

more organized.

Introducing an Actor
Now you can start writing some code.  
Go back to IDLE and write this line of code  
in the editor window, then press Enter.

5

L I N G O

Actors and Sprites
In computer games development,  
a sprite is an object, like a coin or an  
enemy character, that is controlled by  
code. Actors in Python are like Sprites  
in Scratch. An Actor can be drawn on  
the screen, moved around, and even 
interact with other Actors in the  
game. Each Actor is given a “script”  
(the Python code) to tell it how to  
behave in the game.

 apple = Actor("apple")

   New Folder

   Get Info

   Clean up  

   Clean up by              ▶

S H O O T  T H E  F R U I T

shoot.py
images

shoot-the-fruit

apple.png

This is such  
an honor!

This creates  
a new Actor  
called apple.
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Drawing the apple on the screen
Next you need to “draw” the apple on the screen. 
To do this, you can use a built-in Pygame Zero 
function called draw(). This function is used  
to redraw the game screen. For example, if a 
character has moved or a score has changed,  
you can use this function to update the screen 
with those changes. Write this code beneath 
your previous code.

6

This function  
is called draw().

Remember, you need 
four blank spaces here.

This clears  
the screen.

This line draws the  
apple on the screen.

Test the code
Now it’s time to test the code. Run the 
program by using the command line in  
the Command Prompt or Terminal window. 
Check out pages 24–25 if you need to 
remind yourself how to do this.

7

Drag and drop your shoot.py 
file here to run it. apple = Actor("apple") 

 def draw():

    screen.clear( )

    apple.draw( )

First screen
If your code is working properly, you  
should see this screen. If it’s not, or if  
you get an error message, go back and  
check your code to find any bugs.

8

    apple.draw()

 def place_apple( ):

    apple.x = 300

    apple.y = 200

A blank game 
window with 
an apple in the 
top-left corner 
of the screen 
should appear.

Pygame Zero Game

If you need help  
running your game,  
check pages 24–25.

You must save your program 
before running it, or I’ll run 
an old version of your code.

Placing the apple
At the moment, the apple appears in the 
top-left corner of the game window. You can 
change the code to place the apple exactly 
where you want it on the screen. Write this 
function, which will place the apple at the 
coordinates (300, 200).

9

The apple will be 
placed 300 pixels 
along the x-axis 
(horizontal).

The apple will be placed 200 
pixels down the y-axis (vertical).

 pgzrun

G A M E  P R O G R E S S                              5 3 %
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À fruit_ninja_basic

Save your game

To save your file click on the save button . Now

coderdojo_tramore folder.

fruit_ninja_games file as fruit_ninja_basic.py

fruit_ninja_basic.py

fruit_ninja_games

Set up an image folder

This game uses an image of an apple. Within your

fruit_ninja_games folder you want to create a folder

called images.

Click on the image button and you should see an

empty folder where you need to put your images.

fruit_ninja_games

fruit_ninja_basic.py

I have put a copy of
this resource pack in the
folder resources

Mu

Test your code

To test your code, click on the play button .

To stop, click on the stop button,
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 def place_apple( ):

    apple.x = 300

    apple.y = 200

place_apple( )

Running the function
After you’ve written the function to place the  
apple on the screen, you need to tell Python  
to run it. Add this extra line of code to run the 
function called place_apple().

Test it again
Save your file and then run the code from  
the command line. Remember, you can press 
the Up arrow in the command line to quickly 
choose a previous command, then press  
Enter. This time the apple will appear at  
the point (300, 200).

10 11

The apple is placed at 
coordinates (300, 200).

(300, 200)

This function 
places the apple 
at coordinates 
(300, 200).

Run fast or we’ll  
miss the bus!

E X P E R T  T I P S

Graphics in Pygame
Python uses coordinates to identify all the 
places in a window where an object could be. 
This means that every place can be identified  
by using two numbers. The first number is  
the x coordinate, which shows how far to the 
right an object is. The second number is the  
y coordinate, which shows how far down  
the object is. Coordinates are written in 
parentheses, with the x coordinate first, like this:  
(x, y). In math, the coordinate (0, 0) is usually  
at the bottom left, but in computer graphics,  
it’s almost always the top left.

(130, 140)

20 40 60 80 100 120 140

20

40

60

80

100

120

140

y g
ettin

g
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ig
g

er

x getting bigger

(0, 0)

Pygame Zero Game

These are the 
coordinates 
of the star  
on screen.

S H O O T  T H E  F R U I T
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 def place_apple():

    apple.x = 300

    apple.y = 200

 def on_mouse_down(pos):

    print("Good shot!")

    place_apple()

 place_apple()

Dealing with clicks
Now it’s time to write the code that 
will run when you press the mouse. 
Pygame Zero has a built-in function 
called on_mouse_down(), which is 
run every time you click the mouse. 
Type this code in between the code 
you added in Step 9 and Step 10, 
then run it from the command line. 
You should see the message “Good 
shot!” in the Command Prompt or 
Terminal window each time you 
click the mouse. 

12
Programmers sometimes  
add blank lines to make their 
code neater, but they aren’t 
necessary. Python ignores 
blank lines completely.

Adding some logic
At this point, the “Good shot!” message is displayed 
every time you click the mouse, but we only want  
it to show if the player actually hits the apple. You can 
do this by amending the code from Steps 10 and 12 to 
include an if statement. This code checks if the apple 
and the mouse cursor are in the same position. If they 
are, the message is displayed.

13

pos is the position of  
the cursor when you 
click the mouse.

This function 
checks if the 
cursor is in the 
same position  
as the apple.

Make sure the bottom 
two lines now start 
with eight spaces.

Whoa!  
Good shot!

START

1 2 3 4 5

E X P E R T  T I P S

Indents
Python uses indents to separate different 
blocks of code. If your indents are wrong, 
Python won’t know how to read your code,  
and you’ll end up with a bug! Each indent  
is made up of four spaces, and code can be 
indented more than once—for example,  
by eight spaces. Sometimes IDLE adds the 
indents for you, but if you’re moving the  
code around, like in Step 13, you might  
need to indent it yourself. You can do this  
by entering the correct number of spaces.

 def on_mouse_down(pos):

    if apple.collidepoint(pos):

        print("Good shot!")

        place_apple()

G A M E  P R O G R E S S                              7 6 %
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À fruit_ninja_basic
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Time to shoot!
You did it! Run your program to play the game. 
Each time you “shoot” the apple, it will move  
to a random place on the screen for you to 
“shoot” again.

Importing Random
The game is very easy at this point, because the 
apple is always drawn at the same place on the 
screen. You can use Python’s Random module to 
make the game more challenging by placing the 
apple at a random point on the screen each time it 
is drawn. First, add this code at the very top of  
your program.

Using Random
Change the code you typed in Step 9 to look like 
this. The code will now use the randint() function 
to pick a random number between 10 and 800 for 
the x coordinate and a random number between 
10 and 600 for the y coordinate. 

Missed a shot? Game over!
Add some more logic to your code,  
so that if you miss a shot and don’t 
click on the apple, it quits the game. 
Try it out!

Random numbers
Rolling a dice, picking a card from a deck, 
or tossing a coin are all actions that you 
can simulate by generating a random 
number. You can read more about how to 
use Python’s Random module by going to 
the Help menu and clicking Python Docs.

I sure have  
good aim!

Pick a card,  
any card.

17

15

16

14

E X P E R T  T I P S

This imports the 
function randint() 
from Python’s 
Random module.

This function picks a 
random number for  
each coordinate.

This command quits the game by 
stopping the program completely. 

    if apple.collidepoint(pos):

        print("Good shot!")

        place_apple()

    else:

        print("You missed!")

        quit()

 def place_apple( ):

    apple.x = randint(10, 800)

    apple.y = randint(10, 600)

 from random import randint

 apple = Actor("apple")
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△ Fruit salad
The Actor doesn’t need to be an apple! Find a picture of 
another fruit in the Python Games Resource Pack or create 
one using an 8-bit editor online. Make sure you’ve got a 
suitably sized image before you save it in the images folder. 
Then name the image and change the code accordingly to 
use the new fruit as an Actor.

△ Keep on playing
This game is fun for people who want to practice 
using a mouse. However, it could get frustrating  
if the game quits every time you click in the 
wrong place. Can you find the command that 
quits the game and remove it to make the game 
easier to play?

△ Don’t shoot!
Why not add another Actor to the game to 
distract the player in the hope they’ll click on 
that object by mistake? For instance, a red ball 
might look similar enough to an apple to fool 
the player!

SHOOT THE FRUIT

△ Keep count
Change your code so that it can keep count of the number 
of times you click successfully. Here are some hints to  
help you out.

▪ Store the count in a variable.
▪ Start by setting the variable to 0.
▪ Increase the count by 1 each time you click on the apple.
▪ Use print() to show the score in the Command Prompt  
   or Terminal window each time the apple is drawn on 
   the screen.

Hacks and tweaks
Now that you’ve created your first game, it’s time 
to think about how you can change it to make the 
game even more fun. Here are some hacks and 
tweaks for you to play around with.

 kiwi = Actor("kiwi")

Page 28 will help you 
with the variable!

G A M E  P R O G R E S S                              1 0 0 %
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1 Code review
The Coding Games with Python is very good, but it does do somethings that we can improve on.
Before we move on we are going to look at our code and see if we can improve it. We are not
trying to change what it does — that will come later — instead we want to make the code easier
for humans to read and easier for humans to update when they think of something new to add
to the game.
So we will make a number of changes:

 Click on new file icon, , and copy the code from fruit_ninja_basic into this new file.
Save, using icon , as file fruit_ninja_refactored.py. Finally update the file using the
following steps:

À We set the size of the screen using WIDTH and HEIGHT global variables.

Á Change name from apple to fruit as later we want to deal with more than apples.

Â Change name of function place_apple to place_fruit as we will use this function to
place all fruits.
Ã Change the limits in function randint so that the fruit will appear fully on the screen.
Now, because we have define global variables WIDTH and HEIGHT we can limit the random
position of the fruit based on the screen size.

fruit_ninja_basic
from random import randint

apple = Actor("apple")

def draw():
screen.clear()
apple.draw()

def place_apple():
apple.x = randint(10, 800)
apple.y = randint(10, 600)

def on_mouse_down(pos):
if apple.collidepoint(pos):

print("Good shot!")
place_apple()

else:
print("You missed!")
quit()

place_apple()

fruit_ninja_refactored
from random import randint

WIDTH, HEIGHT = 600, 600

fruit = Actor("apple")

def draw():
screen.clear()
fruit.draw()

def place_fruit():
fruit.x = randint(20, WIDTH − 20)
fruit.y = randint(20, HEIGHT − 20)

def on_mouse_down(pos):
if fruit.collidepoint(pos):

print("Good shot!")
place_fruit()

else:
print("You missed!")
quit()

place_fruit()

À
Á

Â
Ã

What is code refactoring?
Code refactoring is the process of restructuring existing computer code to improve its

readability or structure, with the explicit purpose of keeping its meaning or behaviour.

Refactoring is the part of code maintenance which doesn’t fix bugs or add new function-

ality. Rather it is designed to improve the understandability of the code, to make it easier

for human maintenance in the future.
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2 Adding sound effects
One of the reasons we switched over from turtle graphics to Pygame Zero is to simplify generating
sounds — both short term sound effects and long term background music.
Pygame Zero treats sound effects and background music separately.

2.1 (Short term) Sound effects

A sound effect is a short (less than a few seconds) audio that is usually played in response to
something happening in a game — target was hit, player died, etc.. To create sound effects you
(I have carried out these steps already for you, but list them here so you can try out your own
sound effects):

• Find a suitable sound effect. The website www.zapsplat.com, has an
excellent search engine and a large collection of free sounds. You
need to pay for the WAV format, but the MP3 format is free. I always
use the MP3 format.

For example, for this game I searched “target” and found sound ‘Clay pigeon shooting, gun shoots and people

cheer, UK 2’. This has a splay sound and a cheer — I will use both.

• Convert the sound to WAV format. I use the free audio editor Audac-
ity, (www.audacityteam.org), to edit sound effects and exporting them
as MP3 format.

For example, using the Clay pigeon shooting, gun shoots and people cheer, UK 2 sound I saved two WAV file —

one contained just the splat sound and the second the splat and cheer sound.

• Copy the sound file into the sounds sub-folder of fruit_ninja_games. Make sure that
you rename your file so that it uses lower case letters, underscore and numbers only, and
that it starts with a letter.

For example, in this game I have two sound effects called shoot.wav and shoot_and_cheer.wav

• Now wherever in your code you want to play sound, NAME, you use sounds.NAME.play().

For example, I wanted to play the ‘shoot’ sound every time the target is hit and on average every ten hits it plays

the ‘shoot_and_cheer’ also so I wrote the following code

 Click on new file icon, , and copy the code from fruit_ninja_refactored into this new
file. Save, using icon , as file fruit_ninja_sounds.py. Finally, insert the following code.

19 if fruit.collidepoint(pos):
20 print("Good shot!")
21 if randint(1,10)==1:
22 sounds.shoot_and_cheer.play()
23 else:
24 sounds.shoot.play()
25 place_fruit()

https://www.zapsplat.com
https://www.zapsplat.com
https://www.zapsplat.com/music/clay-pigeon-shooting-thrower-machine-release-clay-gun-shoots-and-people-cheer-uk-2/
https://www.zapsplat.com/music/clay-pigeon-shooting-thrower-machine-release-clay-gun-shoots-and-people-cheer-uk-2/
https://www.audacityteam.org
https://www.audacityteam.org
https://www.zapsplat.com/music/clay-pigeon-shooting-thrower-machine-release-clay-gun-shoots-and-people-cheer-uk-2/
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2.2 (Long term) Background music

Background music is usually a longer piece of audio and often run in a loop so it repeats until the
game is over. To play background music you:

• Find a suitable sound track. I like the website www.melody-
loops.com. It has a good selection of tracks and it has a nice
feature of cutting the tracks to whatever length you want and
control fade in at the start and fade out at the end of the tracks.

For example, for this game I picked The French Lovers Song and set its length to be 90 seconds with a few second

fade out at the end.

• Copy the sound file into the music sub-folder of fruit_ninja_games. Make sure that you
rename your file so that it uses lower case letters, underscore and numbers only, and that
it starts with a letter.

I renamed the downloaded file as the_french_lovers_song.mp3.

• Then to

– play this track in a loop forever, use code: music.play("the_french_lovers_song").

– play this track once, use code: music.play_once("the_french_lovers_song").

– stop the currently playing track, use code: music.stop().

– pause use code: music.pause() and to unpause, use code: music.unpause().

– fade out and stop after ‘duration’ seconds, use code: music.fadeout(duration).

– set volume with value in range 0…1, use code: music.set_volume(volume).

 Addcode toplay thethe_french_lovers_songor toplaytrap_ashamaluev_musicwhich
I found on soundcloud and also downloaded to music sub-folder.

3 Keeping score (and multiple lives)
3.1 Keeping score

Currently the game just prints out a different message whenever you miss or hit a fruit. It would
be nicer to keep score so that you can show off your shooting skills. To do this we will create
a new variable called score. Also we will add a heads up display (HUD) to show the score and
game title.

 Click on new file icon, , and copy the code from fruit_ninja_sounds into this new file.
Save, using icon , as file fruit_ninja_score.py. Finally, update the code as follows.

Step 1) Create variables to store the required information.
I like to store this information within an actor. So I after creating the actor fruit I write
the following:

fruit.score = 0

https://www.melodyloops.com/music/
https://www.melodyloops.com/music/
https://www.melodyloops.com/music/
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Step 2) Update variables when needed.
For the score, we want to increase this by one every time we hit the target, so we have

if fruit.collidepoint(pos):
fruit.score = fruit.score + 1

Step 3) Display information.
For all our games, I’m going to display the score on the
top left, the game name in the centre, and lives (or other
information) on the top right. So the screen looks like this.
The code to produce the game title and score is as follows:

screen.draw.text("Score %s" % fruit.score,
topleft=(0, 0))

screen.draw.text("Fruit Ninja",
midtop=(WIDTH // 2, 0), color="orange", fontsize=60)

3.2 Multiple lives

 Now you need to write similar code for multiple lives. You start with three lives and every
time you miss a target you lose a life. When you have no lives left the game is over.

4 Moving targets
Rather than placing the fruit in a randompositionwe couldmake the gamemuchmore interesting
by having moving fruit. I think that the nicest effect is to ‘throw’ fruit up from below the screen
and have them fall back down due to gravity. This sounds complicated but it actually easy to do.

 Click on new file icon, , and copy the code from fruit_ninja_sounds into this new file.
Save, using icon , as file fruit_ninja_physics.py. Finally, update the code as follows.

All fruit start below the screen

Fruit are thrown (nearly)
upwards, and towards the
centre
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Step 0) Plan you code.
The function place_fruit does a few things so lets be good programmers and plan what
we are going to do.

 Import the 2-dimensional vector from pygame.math library at the start of your pro-
gram so that we can treat our horizontal (𝑥) and vertical (𝑦) movement together.

from pygame.math import Vector2 as Vector

 Change the function place_fruit so it just contains the following comments. We
will fill in the details or each in the following sections.

def place_fruit():

# random po s i t i o n below the screen

# random ve l o c i t y − f r u i t thrown towards the cen t r e

# acce l e r a t i on due to g r a v i t y

Step 1) Set the starting position.
We want the fruit to appear anywhere along the bottom edge of the screen — so we set
the 𝑥-coordinate to be random value in the range 20 to WIDTH−20.
We want the fruit to appear from below the screen — so we set the 𝑦 coordinate to be the
screen height plus some margin.

# random po s i t i o n ( j u s t below the screen )
x = randint(20, WIDTH − 20)
y = HEIGHT + 20
fruit.pos = Vector(x, y)

Step 2) Set the starting velocity.
We want the fruit to be thrown upward to a random height so dy, the velocity along the
𝑦-direction, is set to be a random value in range 10 to 20. These numbers were picked by
trial and error, so the fruit would just go up to top of screen before falling back down.

# random ve l o c i t y − f r u i t thrown towards the cen t r e
dy = −randint(20, 25)

Note the minus sign. This is because 𝑦-direction points downwards.

If the 𝑥-direction component the velocity, dx, is zero then the fruit will just go directly up
and then fall back down — this is a bit boring. But if we set dx to a too large a value the fruit
will fly past the side of the screen, and we won’t have time to click on it. So we will change
the sign of dx so that the fruit is thrown towards the centre.

dx = randint(0, 5)
if fruit.x > WIDTH / 2:

dx = −dx
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Finally, we now can set the velocity

fruit.velocity = Vector(dx, dy)

Step 3) Set the acceleration.

On Earth acceleration due to gravity is 9.81 metres per second squared, but in our game
time does not run at the same rate so we can use a smaller value

# acce l e r a t i on due to g r a v i t y
fruit.acceleration = Vector(0, 0.5)

Step 4) Update velocity and position.

So now, all we have done is set the starting state of the fruit. How does it move?

Physics — or a sub-area of physics, called projectile movement — comes to our aid.

We have an object, an apple, that has position and velocity and is subjected to a fix accel-
eration1 (gravity) how does it move. We have two equations

velocity = rate of change of position

acceleration = rate of change of velocity

What is the ‘rate of change’ of something? It is the change (new−old) divided by the length
of time over which the change occurred. So we have

(velocity) = (rate of change of position) =
(new position) − (old position)

(time duration)

Rearranging this we get

(new position) = (old position) + (time duration) × (velocity)

In our game world we will let (time duration) to be equal to one so the above equation to
update position can be written as

fruit.pos = fruit.pos + fruit.velocity

We do this type of updating so often that python has an alternative, more compact, style

fruit.pos += fruit.velocity

Using the same logic we can go from equation

acceleration = rate of change of velocity

to python code

fruit.velocity += fruit.acceleration

1Remember, unlike in everyday speech, ‘acceleration’ does not just mean we go faster. It means that our velocity
changes, i.e. speed increases or decreases or/and direction changes.
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We now want to run the two lines to update velocity and position over and over and over
and over and …. We do this by defining the function updatewhen is a special function that
runs 60 times a second.

 Insert the following function.

def update():
# apply phys ic s
fruit.velocity = fruit.velocity + fruit.acceleration
fruit.pos = fruit.pos + fruit.velocity

# f e l l below screen so ge t new f r u i t
if fruit.y > HEIGHT + 30:

place_fruit()

Note:

– We always update velocity before we update position. This will give us more accurate
behaviour to help correct the fact that we only update 60 times a second but in reality
Physcis is update continuously.

– When the fruit falls below the screen again, we ‘throw’ a new fruit.

Update: You can also get a rotating effect by changing the property angle of you fruit.

5 Multiple targets (and not all fruit!)
We have one final improvement to make to our game. Rather than always throwing an apple we
could throw different fruit. Or even better sometimes throw non-fruit items which we are NOT
to click on.
I won’t write the steps to do this here — instead we will cover this in the dojo — however we need
some images.
For game art, I like the site www.gameartguppy.com which was de-
veloped by Vicki Wenderlich to “give game devs who can’t afford
custom art (yet) an easy way to find and use free and inexpensive
art.”
I haveput in someof the food collectionof images that I downloaded fromwww.gameartguppy.com
into coderdojo−tramore/resources folder.

https://www.gameartguppy.com/product-category/game-art-character-sprites/
https://www.gameartguppy.com/product-category/game-art-character-sprites/
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